PRINTED MANUAL

© 1999-2016 AGG Software

Serial Printer Logger
© 1999-2016 AGG Software
All rights reserved. No parts of this work may be reproduced in any form or by any means - graphic, electronic, or
mechanical, including photocopying, recording, taping, or information storage and retrieval systems - without the
written permission of the publisher.
Products that are referred to in this document may be either trademarks and/or registered trademarks of the
respective owners. The publisher and the author make no claim to these trademarks.
While every precaution has been taken in the preparation of this document, the publisher and the author assume no
responsibility for errors or omissions, or for damages resulting from the use of information contained in this
document or from the use of programs and source code that may accompany it. In no event shall the publisher and
the author be liable for any loss of profit or any other commercial damage caused or alleged to have been caused
directly or indirectly by this document.
Printed: 29.11.2016

Publisher
AGG Software
Production
© 1999-2016 AGG Software
http://www.aggsoft.com

Contents

I

Table of Contents
Part 1 Introduction

1

1 About
...................................................................................................................................
Serial Printer Logger
1
2 Glossary
................................................................................................................................... 2

Part 2 License, Registration and
technical support

4

1 License
................................................................................................................................... 4
2 Limitations
................................................................................................................................... 5
3 How...................................................................................................................................
to register
5
4 Support
................................................................................................................................... 6

Part 3 Installation

6

1 System
...................................................................................................................................
requirements
6
2 Installation
...................................................................................................................................
process
6

Part 4 Program use

7

1 Getting
...................................................................................................................................
started
7
2 Introduction
................................................................................................................................... 8
3 Data
...................................................................................................................................
flow diagram
10
4 Work
...................................................................................................................................
complete
11
5 Useful
...................................................................................................................................
advices
11
6 Configuration
................................................................................................................................... 12
Serial port......................................................................................................................................................... 12
Serial (COM)
..................................................................................................................................................
port
12
Additional.........................................................................................................................................................
param eters
17
Data view ..................................................................................................................................................
change
17
Date/time configuration
.................................................................................................................................................. 19
Name and ..................................................................................................................................................
security
20
Log files ......................................................................................................................................................... 22
Log rotation
.................................................................................................................................................. 22
Log file access
.................................................................................................................................................. 24
Log deletion
.................................................................................................................................................. 25
PDF/RTF logging
.................................................................................................................................................. 26
Introduction........................................................................................................................................... 26
System requirements
........................................................................................................................................... 27
Installing PDF/RTF
...........................................................................................................................................
logging
27
Glossary ........................................................................................................................................... 30
Setup
........................................................................................................................................... 30

7 Program
...................................................................................................................................
options
33
Window view
......................................................................................................................................................... 33
Date/tim e .........................................................................................................................................................
stam p view
35
Protocol and
.........................................................................................................................................................
errors handling
36

© 1999-2016 AGG Software

II

Serial Printer Logger
Service m.........................................................................................................................................................
ode on Window s 2000+
37
Configuration
.................................................................................................................................................. 37
Window s Vista+
..................................................................................................................................................
notes
41
Restart & Security
......................................................................................................................................................... 42

0

Part 5 Serial communications overview

1 RS-232
................................................................................................................................... 0
2 DB9...................................................................................................................................
(9 pin) RS-232 port pinout
0
3 DB25
...................................................................................................................................
(25 pin) RS-232 port pinout
0
4 RS-232
...................................................................................................................................
loopback devices
0
5 RS-232
...................................................................................................................................
data transfer cables
0

43

Part 6 Having problems?

1 Program
...................................................................................................................................
doesn't run or work
43
2 FAQ
................................................................................................................................... 44

© 1999-2016 AGG Software

Introduction

1

Introduction

1.1

About Serial Printer Logger
Serial Printer Logger captures data flow from a serial printers and interprets to electronic documents
like Microsoft Word or Adobe PDF. Serial Printer Logger provides real-time data collection from dotmatrix printers that connected via RS232, RS485 or Ethernet.
Serial Printer Logger captures serial or network data and writes to a binary log file with RAW data or
decode ESC/P control codes and transfers the data to electronic documents.
Key features of Serial Printer Logger is:
capability to log multiple ports at the same time. Each port may have fully different settings;
supports most ESC/P and ESC/P 2 control codes, except custom characters;
captures and decodes bitmap or raster graphics;
supports different fonts types and sizes;
supports various paper sizes;
supports date/time stamping;
outputs received data without any changes to a log file;
data export to ready-to-use Microsoft Word (RTF) or Adobe PDF files;
program messages logging;
simple, menu-driven step by step set-up - programming is not required to configure the software
to collect data;
many plug-in modules that extending program features;
Supporting various operating systems. It runs under all versions starting from Windows 2000,
including 32 and 64-bit systems..
Unlike most other serial logging applications, Serial Printer Logger can run as a service so that it
starts as soon as the operating system starts and doesn't require a user to log in and run it. It will
continue to run even as users logon and logoff the workstation.
It is extremely easy to use! The configuration process is fully menu driven and has complete,
context sensitive, on-line help. you can easily customize all input to your exact specifications. Once
you see how easy it is to use Serial Printer Logger, you will never again take data readings by hand!

Typical usage
A typical application for Serial Printer Logger is to replace one or more dot-matrix printers with one
PC that will capture and store documents electronically.

Applications examples
Data logging systems;
Remote control systems;
Alarm systems.

Company home page: http://www.aggsoft.com/
Software home page: http://www.aggsoft.com/serial-printer-logger.htm
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Glossary
ASCII - An acronym for American Standard Code for Information Interchange. ASCII files are plain,
unformatted text files that are understood by virtually any computer. Windows Notepad and virtually
any word processor can read and create ASCII files. ASCII files usually have the extension .TXT (e.
g., README.TXT).
Binary File - A file that contains data or program instructions written in ASCII and extended ASCII
characters.
Bit - Binary digit in the binary numbering system. Its value can be 0 or 1. In an 8-bit character
scheme, it takes 8 bits to make a byte (character) of data.
Bytes - A collection of eight bits that represent a character, letter or punctuation mark.
Cable - Transmission medium of copper wire or optical fiber wrapped in a protective cover.
Client/Server - A networking system in which one or more file servers (Server) provide services;
such as network management, application and centralized data storage for workstations (Clients).
COM port - Short for a serial communication port. Most serial communication software
communicate with a computer through a communication port, and most IBM and IBM-compatible
computers support up to four serial ports COM1, COM2, COM3 and COM4. Additional ports can be
added by adding additional hardware.
Data bits - A group of bits (1's and 0's) that represent a single character or byte. Typically, there are
seven or eight data bits. During an asynchronous communication (e.g., BitCom connecting to
CompuServe), each side must agree on the number of data bits. Data bits are preceded by a start
bit and followed by an optional parity bit and one or more stop bits.
DNS (Domain Name System) - A DNS server lets you locate computers on a network or the
Internet (TCP/IP network) by domain name. The DNS server maintains a database of domain names
(host names) and their corresponding IP addresses. PC aggsoft's IP address, 198.63.211.24,
corresponds to the DNS name www.aggsoft.com.
Flow control - A method of controlling the amount of data that two devices exchange. In data
communications, flow control prevents one modem from "flooding" the other with data. If data comes
in faster than it can be processed, the receiving side stores the data in a buffer. When the buffer is
nearly full, the receiving side signals the sending side to stop until the buffer has space again.
Between hardware (such as your modem and your computer), hardware flow control is used;
between modems, software flow control is used.
Handshaking - Is the way in which the data flow between computers/hardware is regulated and
controlled. Two distinct kinds of handshaking are described: Software Handshaking and Hardware
Handshaking. An important distinction between the kinds of signals of the interface is between data
signals and control signals. Data signals are simply the pins which actually transmit and receive the
characters, while control signals are everything else.
Internet - A global network of networks used to exchange information using the TCP/IP protocol. It
allows for electronic mail and the accessing ad retrieval of information from remote sources.
IP, Internet Protocol - The Internet Protocol, usually referred to as the TCP/IP protocol stack,
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allows computers residing on different networks to connect across gateways on wide-area networks.
Each node on an IP network is assigned an IP address, typically expressed as 'xx.xx.xx.xx'.
IP address (Internet Protocol address) - The address of a computer attached to a TCP/IP
network. Every client and server station must have a unique IP address. Client workstations have
either a permanent address or one that is dynamically assigned to them each dial-up session. IP
addresses are written as four sets of numbers separated by periods; for example, 198.63.211.24.
LAN (Local Area Network) - A network connecting computers in a relatively small area such as a
building.
NIC, Network Interface Card - A card containing the circuitry necessary to connect a computer to
a particular network media. Typically, the NIC plugs into the computer's accessory bus, (PCI, USB,
etc.) and provides a network connection such as 10baseFL (fiber ethernet), thin-net, AUI, etc.

PC - abbreviation for a Personal Computer.
Parity - In data communications, parity is a simple procedure of checking the integrity of transmitted
data. The most common type of parity is Even, in which the number of 1's in a byte of data add up to
an even number, and None, in which a parity bit is not added.
Ports - A connection point for a cable.
Protocol -A formal description of a set of rules and conventions that govern how devices on a
network exchange information.
RS232, RS423, RS422 AND RS485 - The Electronics Industry Association (EIA) has produced
standards for RS232, RS423, RS422, and RS485 that deal with data communications. EIA
standards where previously marked with the prefix "RS" to indicate the recommended standard.
Presently, the standards are now generally indicated as "EIA" standards to identify the standards
organization.
Electronic data communications will generally fall into two broad categories: single-ended and
differential. RS232 (single-ended) was introduced in 1962. RS232 has remained widely used,
especially with CNC control builders. The specification allows for data transmission from one
transmitter to one receiver at relatively slow data rates (up to 20K bits/second) and short distances
(up to 50' @ the maximum data rate). This 50' limitation can usually be exceeded to distances of
200' or more by using low capacitance cable and keeping the data rates down to 9600 baud and
lower.
RTS/CTS Hardware handshaking - uses additional wires to tell a sending device when to stop or
start sending data. DTR and RTS refer to these Hardware handshaking lines. you can select whether
you need to use DTR or RTS individually, or use both lines for hardware handshaking. See also Xon/
Xoff.
TCP/IP, Transport Control Protocol / Internet Protocol - TCP and IP are communications
protocols, that is, structured languages in which data is communicated between one process and
another, and between one network and another. TCP/IP is implemented in a multi-level layered
structure.
TCP/IP is the 'glue' that that ties together the many heterogeneous networks that make up the
Internet.
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Stop bits - In data communication, one or two bits used to mark the end of a byte (or character). At
least one stop bit is always sent.

2

License, Registration and technical support

2.1

License
Copyright © 1999-2016 AGG Software.
All Rights Reserved

SOFTWARE LICENSE
Trial Limited Version
The trial limited version of this software may be used for evaluation purposes at the user's own risk
for a trial period. At the end of the trial period, the user must either purchase a license to continue
using the software, or remove it from his/her system.
The trial limited version may be freely distributed, provided the distribution package is not modified.
No person or company may charge a fee for the distribution of Serial Printer Logger without written
permission from the copyright holder.

Licensed Version
On payment of the appropriate license fee, the user is granted a non-exclusive license to use Serial
Printer Logger on one computer (i.e. a single CPU), for any legal purpose, at a time. The registered
software may not be rented or leased, but may be permanently transferred, if the person receiving it
agrees to terms of this license. If the software is an update, the transfer must include the update and
all previous versions.
Registered customer are entitled to free updates during one year from the date of purchase. It
means that during one year you can download and install the latest registered versions of Serial
Printer Logger from our site. If you don't want to purchase an updates, you can use the program
forever; it will never expire, but you won't be able to use the latest version. If you purchased the
software more than one year ago, you are no longer entitled to free upgrade and technical support;
however, you can purchase an updates to the latest version at a special, greatly discounted price,
and this updates will allow you to have free updates and technical support for another year. The type
of update license must match the type of your existing license.
Whilst every care has been taken in the construction and testing of this software, it is supplied
subject to the condition that the user undertakes to evaluate the suitability of the control for his/her
purposes. AGG Software makes no representation of the software's suitability for any purpose, and
the user agrees that AGG Software has no responsibility for any loss or damage occasioned by the
use of this software.
TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE SOFTWARE AND
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DOCUMENTATION ARE PROVIDED "AS IS" AND AGG SOFTWARE DISCLAIMS ALL OTHER
WARRANTIES AND CONDITIONS, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE, CONFORMANCE WITH DESCRIPTION, TITLE AND NON-INFRINGEMENT OF THIRD
PARTY RIGHTS.
TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL AGG
SOFTWARE BE LIABLE FOR ANY INDIRECT, INCIDENTAL, CONSEQUENTIAL, SPECIAL OR
EXEMPLARY DAMAGES OR LOST PROFITS WHATSOEVER (INCLUDING, WITHOUT
LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION,
LOSS OF BUSINESS INFORMATION, OR ANY OTHER PECUNIARY LOSS) ARISING OUT OF
THE USE OR INABILITY TO USE THE SOFTWARE PRODUCT, EVEN IF AGG SOFTWARE HAS
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE, AGG SOFTWARE'S
CUMULATIVE AND ENTIRE LIABILITY TO YOU OR ANY OTHER PARTY FOR ANY LOSS OR
DAMAGES RESULTING FROM ANY CLAIMS, DEMANDS OR ACTIONS ARISING OUT OF OR
RELATING TO THIS AGREEMENT SHALL NOT EXCEED THE PURCHASE PRICE PAID FOR
THIS LICENSE.
Should any term of these terms and conditions be declared void or unenforceable by any court of
competent jurisdiction, such declaration shall have no effect on the remaining terms hereof.
If you do not agree to these conditions you should not install this software.

2.2

Limitations
Program is distributed on shareware terms. This means limited and unavailable secondary program
possibilities, which become valuable or available after program registration. To register the program
read here 5 .
In trial version of our program are the following limits:
Trial period is limited by 21 days. After that time program won't work until it is registered.
Continuous program work time is limited. After set period a message will be displayed and
program stops its work;

2.3

How to register
The program is distributed on shareware terms. This signifies limited or unavailable many features of
the program, getting of full value or available after program registration.
If you'd like to be a registered user, to get information about the release of new versions, to use
technical support and, at last, to get access to disabled functions of the program, register your
copy. For registration, please, read license agreement 4 .
If you want to buy a program through the Internet visit the registration page of our site. On this page
you can get the newest information about the registration process, and also find an order link. After
you've have the form of order registration. Enter your personal information and choose the most
convenient payment method for you. Further, you'll get notification and follow the notes in it.
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More information about services, registration documents, payment means you can get on our
registration page of our site.

2.4

Support
Technical questions

support@aggsoft.com

Common questions

info@aggsoft.com

Sales questions

sales@aggsoft.com

3

Installation

3.1

System requirements
Windows 2000 Professional - Windowsa 8.1, including x64 and x86 OS, Workstation and Server
OS.
It is necessary to have at least one free COM port, not busy by any device (mouse, for example) to
connect external device.
It is necessary to have at least one working network interface (card) in your PC.

3.2

Installation process
If any beta-version was installed on your computer, remove it.
Quit of the working Serial Printer Logger on installation time.
Run an installation file.
By default, Serial Printer Logger will be installed to the directory "/Programs Files/Serial Printer
Logger" of your system disk, but you can change this path.
In the standard distributive of Serial Printer Logger are no additional modules files, which you can
download from our site.
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4.1

Getting started
After you have successfully installed Serial Printer Logger, use the following simple steps to
configure and run it.
Open the Serial Printer Logger program from the Start Menu.
At program run you get into the main program window (fig. 1.1.1), main elements of which are the
main menu, the data window, the program messages list and the status bar. In the data window will
be viewed formatted data processig. In the messages list are logged information, warning and error
messages. The status bar shows current state of the selected data source, interface error
messages and a number of bytes processed. Through the main menu, placed above the data
window, you can get access to program settings 8 ("Options/Program settings...") and from the
menu "File" (fig. 1.1.2) can open an current log-file or clean the data window.

Fig. 1.1.1 Main program w indow

Fig. 1.1.2. "File" m enu item

By default (after installation), the program has not any data sources configured. If the list of data
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sources on the toolbar is empty, then the program will ask you to add new configuration. Otherwise,
the program will fill in the list of data sources and try to start logging of data sources configured.
Yes, of course, all your settings are being saved while exiting from the program and loaded while the
program start.

Set-Up is as Easy as 1-2-3
Step 1. Configure one or more data sources.
Click the "Add configuration" button on the toolbar with big green plus and choose communication
parameters 12 for your device. The "COM Port settings" tab of the "Configuration options" dialog
lets you configure your settings.

Step 2. Configure log file.
Select the "Log file" header in the configuration dialog window and enable logging for a necessary
data direction.

Step 3. Define how you want the printer data to be filtered and exported .
The "Plug-in" button on the toolbar in the main window or "Modules" tab in the dialog window lets
you specify how to parse, filter and format your data to the fit the exact format required by your
application. It also lets you pre-define automatic output strings to be sent to an external device.
Now, the program process and exports data from one or multiple data sources.

4.2

Introduction
Program can work with any kind of serial devices. Before configuring our software, the following
conditions should be executed:
Device should have a RS-232 serial port interface (can be also used a RS-485 interface with an
additional hardware converter);
Device is configured to send data to serial port with or without requests from a PC side;
You know all information about serial port parameters of your device (If your device uses
hardware or software flow control (please, read your device's data sheet), then you should know
about flow control type);
Device's serial port is connected with computer serial port with a cable (null-modem or other
special cable);
Computer's COM port, to which your device is connected is not busy, for example by mouse
software driver.
How to configure port parameters, you can read in the next chapter "Serial port settings

12

".

Program can work with any kind of network interface cards (NIC). Before configuring our software,
the following conditions should be executed:
If your PC has more than one network interface card (NIC) then Serial Printer Logger will display
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a list of all the IP addresses for each NIC installed in your system so that you can select the IP
Address that you want to use. In order for Serial Printer Logger to act as a server, the PC that it
is running on must have at least one network interface card with an IP address assigned to it;
If Serial Printer Logger will work as a server and your PC receives the IP address dynamically
from a DHCP server, then you should ask your network administrator to assign a static IP
address to your PC.
How to configure port parameters, you can read in the next chapter "IP settings".
Serial Printer Logger can save data to a log file(s) without any changes (i.e. create raw binary log
files) or write to log files depending on the parser module selected. In the first case you can view the
log file with any hex editor and use this data for further analysis and remaking. In the second case
you can view data with any text editor. You can find more information about log files in the "Log
rotation 22 " chapter.
You can watch the data in the data window (fig. 1.1.1 7 ). The data view is fully customizable. You
can watch data in decimal, hexadecimal or your own format. How to customize data view you can
read in the "Data view 17 " chapter and how to customize program view you can read in the "Window
view 33 " chapter.
The program and their plug-ins generates many messages and writes they to the list in the main
window (fig. 1.1.1 7 ) and a protocol file, that you can use for administration of the software. You
can configure types of system messages. More information about it you can read in the "Protocol
and errors handling 36 " chapter.
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Data flow diagram
This diagram may help you to understand the flow of data within our software and a place of each
module. All modules are described in following chapters.

Fig. 1.2.1 Data flow diagram

History:
- Binary flow of data (RAW, unformatted data).
- Parsed data (formatted data). The data flow was been separated to data packets and
variables. Each data packet can be interpreted as a row, and each variable can be interpreted as a
column.
Wires with other colors mark other relations with unstructured data flow.
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4.4

Work complete
After program work stop all program settings will be saved in Windows registry. Opened for reading/
writing data sources will be automatically closed and will be available for other applications.

4.5

Useful advices
1. Look through hint helps on all window elements - this will help you to get a picture of this
element's function.
2. You can change all program settings without restarting the program. To transfer settings to
another computer you can do the following:
1. Create a configuration backup from the "File" menu and restore it using the same menu.
2. Or export the registry node with all program settings. Start regedit.exe and export the following
registry node:
on Windows x64
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\AGG Software\Serial Printer Logger
on Windows x32
HKEY_LOCAL_MACHINE\SOFTWARE\AGG Software\Serial Printer Logger
3. On another computer import settings to the Windows registry.
Many main window elements have "hot" keys for quick access to its functions.
Ctrl+S - analogues to click on "Start/Pause" button on toolbar.
Ctrl+C - analogues to click on "Clear" button on toolbar.
Ctrl+P - call options window with configuration settings.
Ctrl+L - call options window with log file settings.
With Ctrl+W hot key You can configure window view.
Ctrl+R - show window with program's restart settings.
Ctrl+E - Windows NT/2000/XP service settings is available here.
Ctrl+M - here you can configure queries, parsers and other modules.
4. You can look at the summary statistic that contains summary about sent and received data,
created files etc (View - Statistics)
5. You can save program settings to an INI file. It may help to install and use several copies of the
program. You can make your choice from the "Options" menu.
6. The program window can display only last 10 message. The full program log file (if activated) you
can open using the "File - View program protocol file" menu item.
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4.6

Configuration

4.6.1

Serial port

4.6.1.1

Serial (COM) port
COM port is short for a serial communication port. Most serial communication software
communicate with a computer through a communication port, and most IBM and IBM-compatible
computers support up to four serial ports COM1, COM2, COM3 and COM4. Additional ports can be
added by adding additional hardware.
Serial Printer Logger can manipulate with many serial ports in the same time (up to 255 serial
ports).
You can open serial ports in Serial Printer Logger software in two modes:
1.

2.

Spy mode. In this mode the program monitor data flow on ports selected. In this mode Serial
Printer Logger intercept all data exchange between any Windows application and external
device;
Standard. In this mode the program opens a serial port through Windows API functions, and
read/write data from/to a serial port as a regular Windows application. In this mode opens a
serial port with exclusive rights and other application will not have access to a serial port.

If one or more port are configured already, then Serial Printer Logger is opening these ports and
starting logging. If the port is opened successful, then the status bar in the main window displays a
status of this port (fig. 1.1.1 7 ). But, before you should configure serial port parameters. For
minimization of configuration we combined serial ports with same settings to the "Configuration". The
configuration can include one or more serial ports with identical settings. For example, if you have
many identical devices, that connected to different serial ports, then you can specify port numbers in
one configuration only. But, if you want to use serial port with different settings, then you should
create more than one configurations.
You can create the new configuration by clicking the "Plus" button in the main window (fig. 1.1.1 7 )
or through the "Options" menu. After you clicked the "Plus" button, the dialog window will be opened
(fig. 2.1.2). The dialog window contains few sections with parameters. The "COM port" section is
described in this chapter.
You can manage the configuration created with a drop down menu near the "Plus" button (fig. 2.1.1).
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Fig. 2.1.1 Access to the port configuration

The "COM port settings" tab contains indispensable settings of any serial port: baud rate, data bits,
etc. You should configure it with same values, that your external device uses for data exchange.

Fig. 2.1.2 COM port param eters

If you are logging data over RS-485 with an additional hardware converter and your converter doesn't
support data direction auto detection, then specify "RS485 interface mode". This option instructs
Serial Printer Logger to set the RTS line at low level while data receiving and vice versa. The serial
port driver can detect errors while data receiving (for example, bad quality of a connection line). You
can specify with the "At data receive error clean incoming buffer" option to ignore data blocks,
that contain errors and clean an incoming buffer.
In some cases the program can't open a serial port while starting (for example, the port is already
used by other application). With the "Try to open after an unsuccessful attempt" option you can
specify to try to open the serial port again after the interval specified. The program will try to open the
serial port until an attempt will successful.
Check line status mode
The Windows communication API provides two methods to check for received data and line/modem
status changes: API calls (polling) and an event word. The event word is maintained by the Windows
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communications driver. As data is received or line/modem status changes occur, the driver sets bits
in the event word. The application can check the bits to determine if any communication events
occurred. If so, the application can make the appropriate API call to clear the event word and retrieve
the data or the new line/modem status values.
Windows also provides API calls to retrieve the same status information provided by the event word
but the API calls are slower. Serial Printer Logger uses the event word by default for the fastest
possible performance. Unfortunately, there is at least one communication driver (WRPI.DRV,
included with some U.S. Robotics modems) that doesn't appear to support the event word. For this
and similar drivers, select other mode before Serial Printer Logger will receive data.
To rise data transmit adequacy you can use hardware and/or software data flow control (fig. 2.1.3).
When using hardware data flow control are used some lines (wires) of connecting cable. Depending
on used lines, you must setup checks against corresponding fields.
Hardware flow control
When the hardware flow control options are an empty, as they are by default, there is no hardware
flow control. The options can be combined to enable hardware flow control.
"Receive flow control" stops a remote device from transmitting while the local input buffer is too full.
"Transmit flow control" stops the local device from transmitting while the remote input buffer is too
full.
Receive flow control is enabled by including the "Use RTS" and/or "Use DTR" elements in the
options. When enabled, the corresponding modem control signals (RTS and/or DTR) are lowered
when the input buffer reaches the 90% size of the buffer. The remote must recognize these signals
and stop sending data while they are held low.
As the application processes received characters, buffer usage eventually drops below the 10% size
of the buffer. At that point, the corresponding modem control signals are raised again. The remote
must recognize these signals and start sending data again.
Transmit flow control is enabled by including the "Require CTS" and/or "Require DSR" elements in
the options. With one or both of these options enabled, the Windows communications driver doesn't
transmit data unless the remote device is providing the corresponding modem status signal (CTS
and/or DSR). The remote must raise and lower these signals when needed to control the flow of
transmitted characters.
Note that flow control using RTS and CTS is much more common than flow control using DTR and
DSR.
Software flow control
This routine turns on one or both aspects of automatic software flow control based on the value
assigned to the property.
"Receive flow control" stops a remote device from transmitting while the local receive buffer is too
full. "Transmit flow control" stops the local device from transmitting while the remote receive buffer is
too full.
Receive flow control is enabled by assigning "On receiving" or "Both" to the "Type" property. When
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enabled, an XOff character is sent when the input buffer reaches the level 10% size of the buffer. The
remote must recognize this character and stop sending data after it is received.
As the application processes received characters, buffer usage eventually drops below the level 10%
of the buffer. At that point, an XOn character is sent. The remote must recognize this character and
start sending data again.
Transmit flow control is enabled by assigning "On transmitting" or "Both" to the "Type" property. The
10% and 90% size of the buffer are not used in this case. When transmit flow control is enabled, the
communications driver stops transmitting whenever it receives an XOff character. The driver does not
start transmitting again until it receives an XOn character or the user sets software flow control to
"None'.
Software data flow control can be setup on receive, transmit or both modes, but so as the great
number of device doesn't need data sending, select only control mode "On receive". In case of
activation of data transmit control remote object (in our case your device) can send special codes,
signalizing about data transmit stop or start. On default, received from device character 0x11 Hex
signalizes to COM port driver to start data receive and character 0x13 Hex - to stop data receive
from device.

Fig. 2.1.3 Data flow control

Spy mode
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In this mode Serial Printer Logger doesn't send and receive any data, and only spies data exchange,
made by other programs.
To spy received and sent data open COM port before running the given program. If the given program
receives data over COM port, the data exchange process will be displayed in data receive window.
Don't forget to set up check box "Spy mode" to spy data receive by the given program (if
necessary).
To exit Serial Printer Logger close the given program or stop data exchange over COM port in it.
you must close, which data exchange you spies, before closing Serial Printer Logger.

Serial data transfer errors
Line errors can occur during data exchange and displayed in the main program window in the status
bar.
UART receiver parity error - occurs if you configured invalid parity type;
UART receiver overrun,
UART receiver framing error - occurs if you configured invalid number of stop or data bits;
transmit timeout waiting for CTS,
transmit timeout waiting for DSR,
transmit timeout waiting for RLSD - occurs if you configured invalid hardware flow control or your
serial interface cable isn't wired for hardware flow control
transmit queue is full - occurs if Serial Printer Logger can't send data to remote device;
break condition received

Port restart
You can also set the program to initiate the serial interface at the specified time. On some old
versions of the Windows NT operating system it could help to avoid the loss of data when the
program has been working for a long time without restarting. Please use the "Additional options" tab
(fig. 2.1.4)
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Fig. 2.1.4 Additional options

Here you can also select the terminal emulation mode. In this mode the program will remove or
interpret some special terminal sequences automatically.

4.6.2
4.6.2.1

Additional parameters
Data view change
The data in the main window (fig.1.1.1
1.
2.

7

) can be displayed in two modes (fig. 3.1.1):

The data can be displayed before processing. Before processing the data I fully comply
with that has been read.
The data can be displayed after processing. After processing the data can be modified
depending on the parser.

© 1999-2016 AGG Software

17

18

Serial Printer Logger

Fig. 3.1.1. Data view

Data view settings, that can be configured on the "Data view" tab:
1.

2.

3.
4.
5.

6.

7.
8.

View characters with code - the program can interpret and decode bytes as characters. You
can select decoding mode for each characters range. If the range doesn't have the
corresponding character, that's why these data can be displayed only in hexadecimal and
decimal code.
You can set up data byte display users format. The directive %d shows to display an decimal
code, the directive %x - hex code. You can set any framing characters before/after the user
format.
Highlight data sent on screen - string with sent data will be highlighted by the set color.
Character set - allows to define the character set of incoming data. Windows - Windows ANSI
character set, DOS - OEM character set.
Data source custom color - if you've created several configurations then you can define a
custom color for each data source that allows to distinguish data flows on the "All data" page in
the main window.
Split strings by data timeout - this option allows to visually split data packets in the program
window. A data packets that will be received after the specified interval will be showed on a new
line. If this value is set to 0 then data packets will not split.
Split continuous data blocks large than - this option allows to visually split continuous data
flow in the program window. The program will show data from a new line every specified interval.
Split by characters - this option allows to visually split continuous data flow in the program
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window using the specified symbols. For example (fig. 3.1.1), the program will use a character
with the 0Ah hexadecimal code that is equal to the "LF" ASCII code.
4.6.2.2

Date/time configuration
This group of options (fig. 3.2.1) allows you to configure how data and time stamps appear in the log
file and on the screen. You can configure the stamp format in the program options 35 .

Fig. 3.2.1 Tim e stam p configuration

Add to display output for data sent - the time stamp will be added for the sent data displayed on
the screen. The stamp will be added according to the timeout (if the data flow is uninterrupted) or
when a data packet is sent.
Add to display output for data received - the same but for the received data.
Add if data direction has been changed - if the program is sending and receiving data, the time
stamp will be also added when the data transfer direction changes (sending/receiving).
Add at begin of file - the stamp will be added at the beginning of every new log file.
Stamp timeout - if the data flow is uninterrupted, the stamp will be added regularly at the interval
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specified in milliseconds.
File prefix/postfix character(s) - the program will use these characters instead of those specified
in the program options 35 while writing data to a file. For example, it allows you to add the new line
character or another sequence of characters before or after the stamp. Example: >#0D#0A

4.6.2.3

Name and security
This group of options (fig. 3.3.1) allows you to configure the following parameters:
Friendly name - this name will be added before the port number or the data source in the dropdown list in the main window of the program. It allows you to describe the data source.
Start logging automatically - if this option is enabled, the program will start receiving and logging
data automatically when it is launched.
The "Security" option group allows you to protect user operations in this particular configuration with
a password. You can specify advanced security options applied to the entire program in the program
options 42 .
Ask password before start and stop - the password will be required when the user clicks the
"Start/Pause" button in the main window of the program.
Ask password before configuration edit - the password will be required when the user tries to
open the Configuration options dialog box.
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4.6.3

Log files

4.6.3.1

Log rotation
The main function of Serial Printer Logger is logging data to a file (so-called, log file). The "Log
rotation" tab has a rich set of options for it. (fig. 4.1.1).

Fig. 4.1.1 Log-file form ing m odes

First of all, select log file what you can configure:
Log file for data received - all data received will be saved here.
Log file for data sent - all data sent will be saved here. If you want to save data to the same
file, as data received, then select the "Log file rotation for data sent" from the list and enable two
options: "Create log files on disk" and "Write to log for data received". Yes, of course, you
should configure a log rotation for data received before.
Set the "Create log file on disk" option to checked state. Then you can set path to folder, where files
will be created with the help of dialog window, which will be showed up after clicking a button with
picture of opening folder. You should select a necessary folder in the dialog window and click the
"OK" button.
Note: The program can work with network paths too, but in this mode, the program will increase
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data flow over a network and can be failed with exceptional errors.
A log file name can be stamped with date and time. In this case a new log file is created
periodically. The time stamp format depends on the selected period. For instance, if the "File name
prefix" field is set to "sample", the "File extension" field to "log" and the "File name format"
option is "Daily", then each log file created will have the format "sampleYYYYMMDD.log". On March
21st, 2003, the log file will be "sample20030321.log". Please, note, that the final extension (after the
final period), remains at the end of the file name.
Log rotation mode is defined by the following key parameters:
File name prefix - text string, which will be added at file name beginning;
File name extension - text string, which will be a file extension (characters after dot);
Limit size - the "Limit size" field specify the maximum size in kilobytes of any log file. If you'll
specify zero size, then the file size will not limited. You may select from the following modes:
1. Clear file - if the log file size will exceed the limit specified, then the log file content will be
deleted and file filling will start from beginning.
2. Rename old - if the log file size will exceed the limit specified then the existing log file will be
renamed.
3. Shift (no threshold) - the older data over the limit specified will removed from the log file.
4. Shift (with threshold). In this mode the program will wait when the file size will exceed the limit
specified + the threshold value. After this, the older data over the limit specified will removed from
the log file.
If the program works continuous for a long time, it is possible that the log file will have large size and
this file will be inconvenient for looking and analysing. For this there is the possibility to create files
in dependence with the time on PC. You can select one variant predefined or set up new one:
Daily - file will be created with name containing prefix, and date in format DDMMYYYY, where
DD is two-digit day sign, MM is two-digit month sign and YYYY is four digits of the current year.
The file name extension will be added at the end of file;
Monthly - file will be created with name containing prefix, and date in MMYYYY format. The file
name extension will be added at the end of file;
Each data packet in different file - in this mode the program splits data flow to a different file.
In this mode you should configure the parser or the program will split a data by timeout about
300 ms.
Don't create new file - in this mode the program will write all data to one file. It is
recommended for a small data flow. Otherwise your log file will be too big and a performance of
the program will fall down;
User's format - file will be created with name containing prefix and date in showed by you
format (for example, DDMMYYYY). The file name extension will be added at the end of file. The
file may not contain format signs, then file name will be constant. You should not use
characters, that the OS doesn't allows in file name, such as "/,\.*,?" and some others;
Weekly - create a new file every week. The file name will contains a week number;
After data timeout - the program will create a new file if the program didn't receive any data at
the specified interval.
Hourly - file will be created with name containing prefix, and date in format YYYYMMDDHH,
where HH is two-digit hour sign, DD is two-digit day sign, MM is two-digit month sign and YYYY
is four digits of the current year. The file name extension will be added at the end of file;
Constantly named file - the current log file will have a constant name. When creating a new
file the existing log file will be saved using the new file name that will contain a data and time
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stamp.
Date and time formatting codes:
d
- day, not adding null(1-31).
dd
- day ,adding null(01-31).
ddd
- day of the week in text form(Mon-Sat) according to standard, set on this computer.
dddd - day of the week in full text form(Monday-Saturday) according to standard, set on this
computer.
m
- month, not adding null(1-12).
mm
- month, adding null (01-12).
mmm - month in text form(Jan-Dec) according to standard, set on this computer.
mmmm - month in full text form (January- December) according to standard, set on this computer.
yy
- year in the form of two last digits(00-99)
yyyy
- year in the form of four last digits (0000-9999).
h
- hours, not adding null (0-23).
hh
- hours, adding null (00-23).
n
- minutes, not adding null (0-59)
nn
- minutes, adding null (00-59).
s
- seconds, not adding null (0-59).
ss
- seconds, adding null (00-59).
Example: you want to create log file every hour. It is desired that file name starts from "sample_log"
and the file extension "txt".
Answer: set file prefix = sample_log_, file extension= txt (without dot!). In file name format show
HHDDMMYYYY. Now file will be created every hour. Naturally, you can set any formatting
characters combination, described higher.
If you want to access to a log file while the program work, then you should configure access mode
settings 24 for the log file in the next chapter.
Add date/time stamp to file name - this option is available for modes #4 and #7 and allows to add
date and time to the file name.
Add data source ID to file name - if this options is activated then then the program will append the
data source name at the beginning of the file name. For example, COM1-sample20030321.log.
Write data/time stamp to file before writing data - if this options is activated then then the
program will write a date/time stamp to a file before each data portion.
Overwrite existing files - this option is available for modes #4 and #7 and allows to delete an
existing log file before creating a new log file.

4.6.3.2

Log file access
During work can be such situations, when it is necessary to get access to a file with current data
(current log file) from other applications (for example, for data processing). But while you are
accessing the current log file Serial Printer Logger can't write data to a log file and all data at this
moment will be lost. We recommend to use a temporary file for data storage. It is most safe way.
(fig. 4.2.1).
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Fig. 4.2.1 File access m ode.

You can select one from following variants:
Ignore and not write - with this mode, the data will be lost;
Write to a temporary file, then append - a temporary file will be created, to which writing will
be done. After access to current file will be got, temporary file content will be added to the end
of main file. But mind that if file is created in dependence of time, there can be a situation when
at temporary file forming name of the main file will be changed. Then temporary file will be added
to the end of newly created file.
Display a message and stop work - data will be lost until dialog window is closed.
You can set up your message text, which will be displayed at writing error to data file. The sound
signal can be on for an additional indication. You can also enable writing a message to a protocol
file.
4.6.3.3

Log deletion
The deletion of files (fig. 4.3.1) will help you to avoid stuffing your hard disk with needless
information. Log files can be deleted either depending on the time of storing or when the maximal
number of files is exceeded.
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When deleting files by the time of their storage, the files that were modified last time before the
specified period are deleted.
When controlling the number of files, the files with the oldest modification dates are deleted first.
You can select both variants of file deletion. In that case files will be deleted when either of the
conditions is true.

Fig. 4.3.1 Log deletion

4.6.3.4

PDF/RTF logging

4.6.3.4.1 Introduction

PDF logging or RTF logging plugin modules allow you to capture data flow from a serial printer to a
Adobe PDF or a Microsoft Word RTF document. Modules create ready-to-use files, so you may reprint these files later, copy to another computer or create a backup copy.
Most printers are using ESC/P codes in their output. The EPSON created the ESC/P printer control
language, the industry standard for simple, sophisticated, efficient operation of dot-matrix printers
was born. With the scalable fonts, high-resolution color raster graphics, and advanced page handling
available with ESC/P 2, EPSON has narrowed the gap between dot-matrix and page printers.
Features previously found only on laser printers are now available at affordable dot-matrix printer
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Our modules support most ESC/P commands and allow to create PDF/RTF documents with
different font types and graphics.
4.6.3.4.2 System requirements

The following requirements must be met for "PDF/RTF logging" to be installed:
Operating system: Windows 2000 SP4 and above, including both x86 and x64 workstations and
servers. A latest service pack for the corresponding OS is required.
Free disk space: Not less than 5 MB of free disk space is recommended.
Special access requirements: You should log on as a user with Administrator rights in order to
install this module.
The main application (core) must be installed, for example, Advanced Serial Data Logger.
Notes for Microsoft Vista and above:
Since our software saves data to the registry and installs to the Program Files folder, the following
requirements must be met:
1. You need Administrator rights to run and install our software
2. The shortcut icon of our software will be located on the desktop;
3. Windows Vista will ask for your confirmation to continue the installation.
NOTE: You can configure the user account only once in order not to see the above dialog box any
more. Search Google for the solution of this problem.

4.6.3.4.3 Installing PDF/RTF logging

1.
2.
3.
4.

Close the main application (for example, Advanced Serial Data Logger) if it is running;
Copy the program to your hard drive;
Run the module installation file with a double click on the file name in Windows Explorer;
Follow the instructions of the installation software. Usually, it is enough just to click the "Next"
button several times;
5. Start the main application. The name of the module will appear on the "Modules" tab of the
"Settings" window if it is successfully installed.
If the module is compatible with the program, its name and version will be displayed in the module
list. You can see examples of installed modules on fig.1-2. Some types of modules require
additional configuration. To do it, just select a module from the list and click the "Setup" button next
to the list. The configuration of the module is described below.
You can see some types of modules on the "Log file" tab. To configure such a module, you should
select it from the "File type" list and click the "Advanced" button.
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Fig.1. Exam ples of installed m odules
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Fig.2. Exam ples of installed m odules
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Fig.3. Exam ples of installed m odules
4.6.3.4.4 Glossary

Plug-in - module
Main program – the program shell that uses this module. For example: Advanced Serial Data
Logger
Parser – the module that processes the data flow singling out data packets from it and variables
from data packets. These variables are used in data export modules after that.
Core - see "Main program".

4.6.3.4.5 Setup

How to enable
This plugin can work in the following products only:
Serial Printer Logger
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Advanced OPC Data Logger
If you want to enable this data logging plugin you should open the "Log rotation" settings and select
the necessary file type (fig. 1). If you will click the "Advanced" button then you may adjust the
document settings below.

Fig.1 Enabling m odule

Document settings
The module allows you to configure the following settings (fig.2):
Decode ESC/P control codes - If you'll activate this option, then our module will extract
information about a font type and graphics from a data flow. Therefore some options in the dialog
window will be disabled.
LQ mode - some printers support LQ mode. This mode allows you to select print quality (draft or
LQ). In the LQ mode graphics have more density, so if you've found that graphics in a document
isn't decoded properly, then try to enable/disable this options.
Paper settings - select paper size in your document
Font type - please, select a font type that you want to use in a document. Some printer fonts
don't exist on a PC, so you should select a font that most compatible with your printer font. In
most cases Courier is a best choice. If you want to use another font, then we recommend to use
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fonts with fixed size of characters like Fixedsys, Courier.
Font size - of you've selected to decode ESC/P codes, then this option is disabled, because
ESC/P controls font size, otherwise your may define size here.
Font charset - if you're printing documents with non-latin characters, then please, select your
charset here.
Bold, Italic - allows you to specify a font type if you've not selected to decode ESC/P codes.
Wrap words - allows you to split very long strings to two or more rows in a document.
Tab indent - the module will replace a <TAB> ASCII code with this number of spaces. This option
is available if you've selected to decode ESC/P codes.

Fig.2 Module settings

Timeouts
Timeouts allows you to avoid data loss, damage and garbage.
Close file (ms) - allows to close the document after this period. If the module didn't receive any
bytes at this interval, then module writes data from an internal buffer to a file and closes a
document. Next time the module opens document again and restores a last outputting position.
Therefore this timeout allows you to increase a module performance, because decreases a
number of "Open/Close" operations. If you'll specify zero in this field, then the module will not use
this timeout.
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Close file button - allows to close file manually.
Reset state (ms) - the module resets its state after this timeout. It allows you to restore an initial
state of the module if a connection with a printer was broken while print a document. After this
timeout the module restores default values of font style, size, graphics mode etc. If you'll specify
zero in this field, then the module will not use this timeout.
Reset button - allows to reset module state manually.
Initialize button - this button resets the module state and additionally resets a last outputting
position.

4.7

Program options

4.7.1

Window view
This tab in program options (fig. 6.1.1) allows you to customize appearance of the main window of
the program (fig.1.1.1 7 ). You can access this tab through the "Options -> Program options" menu
item in the main window.

Fig. 6.1.1 Window view setting

You can set following parameters:
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Start in minimized state - at start Serial Printer Logger will automatically put its icon on panel
near clock (SysTray fig. 6.1.2);
Minimize to SysTray - while the main window of Serial Printer Logger minimizes, the program
will automatically put its icon to the panel near clock;
Show data window - if you specify this option, then the program will display all data in the
main window. If you are logging many ports on slow PC, then you can computer CPU load rate
with disabling of this option;
Output data on screen in minimized state - if you'll enable this option, then the program will
display processed data in minimized state. If you are logging many data sources on slow PC,
then you can decrease computer central processor load rate with disabling of this option;
Font type - the data will be displayed with this font type in the main window only. We
recommend to use mono-spaced fonts in this field, such as: Terminal, Courier etc.;
Screen buffer - at exceeding of value specified the data window will be cleaned;
Window view - will let you setup data window view (font color, font type, background color).
Transparency - in Windows 2000 and later will let you set transparency of the main window.
The most left position is normal window view and most right position is maximum transparency.
Wrap words - if you didn't configure a parser module or your data flow doesn't contain a blocks
separator, then your data without this option enabled will be displayed as one long string in the
data window.

Fig. 6.1.2 Systray - panel near clock
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Date/time stamp view
This group of options (fig. 6.2.1) allows to configure the format of date/time stamps that will be used
in the main program window and log files.

Fig. 6.2.1 Configuring data/stam p view

Prefix/Postfix characters for display output - these options allow to define beginning and ending
characters of a date/time stamp that will be showed in the program window. When outputting data to
a log file the program uses individual characters 19 for each configuration.
View mode - allows to select the standard or define the custom format of the date/time stamp.
Font - this group allows to define the color and font of date/time stamp.
Add data direction sign to a stamp - if this option is activated then the program will append TX or
RX to the end of the stamp.
Add data source ID to a stamp - if this option is activated then the program will data append data
source ID at the beginning of the stamp. For example, COM1.
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4.7.3

Protocol and errors handling
While the program execute, she generates many messages about errors and events. All these
messages are being registered in a protocol file. This can be start or stop of the program, some
messages from plug-in modules etc. On this tab you can define the kind of messages, which you
want to put a protocol file (fig. 6.3.1). Here you can set maximum protocol file size and a formatting
mode. Usually, the protocol file is in a program folder and has the name of the program with the 'log'
extension.

Fig. 6.3.1 Protocol settings

Serial Printer Logger works with three types of messages:
Information messages - this type of messages informs you on operations which are fulfilled in
the current time;
Warnings - warns you of possible failures or possible errors. Interference of the user is not
required, but check is required;
Errors - the program has detected an error which elimination needs involvement of the user.
There is the possibility to log following events:
Program messages - messages about start or stop of the program, etc.;
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Data query - messages which are generated in a data query module;
Data parser - messages which are generated in a data parser module;
Data export - messages which are generated in a data export module;
Other - messages that can not be associated with types above.
You can write each type of messages to a protocol file or/and to the list in the main window. Please,
specify necessary options for each message type at "Window" and "File" fields.
If you don't want to allow to grow a protocol file size to an unlimited size, then you can enable the
"Clean protocol at program start" or limit protocol file size in the "Size" field.
Some exceptional messages can occur while the program execute. In most cases these messages
crash the program and the most safe way is to restart the program. Please, specify the "Restart
program at exception" option and the program will be restarted automatically.
If you want look all program messages, then you can disable the "Don't display messages at
unhandled exceptions" check box and the program will open the exception message window with
detailed information.

4.7.4
4.7.4.1

Service mode on Windows 2000+
Configuration
Windows NT+ services use will let you:
control service on local and remote computers, including remote computers with Windows NT
4.0 system;
setup actions on emergency service restore in case of failure, for example auto service or
computer restart (only on computers with Windows 2000 or later);
create for services other names and descriptions, to find them easier (only on computers with
system Windows 2000 or later);
run service before user login (password input);
service can be setup on automatic start after operation system load.
Note 1: you must be logged in as an administrator in order to change the configuration or control the
service in any way (start, stop, pause, continue).
Note 2: On Windows Vista and later you should start the program with elevated administrator
privileges.
If you want to use the program as a service application, then, please, go to the "Options -> Program
options -> Windows service" tab (fig. 6.4.1), then enable the "Use program as a service" check box.
Later, please, specify the startup type of the service. There can be following variants:
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Fig. 6.4.1 Service settings

1.
2.
3.

Automatic - service will be started automatically at every Windows start, before user login;
Manual - you can start the service application in the "Services" window in the Control panel (fig.
6.4.2);
Disabled - service can't be started.

If you want to change program settings while service mode, then enable the "Allow service to interact
with desktop" option. In this case, the program will put the icon to the SysTray (fig. 6.4.2). But then
your interactive service will be restarted while user log off.

Fig. 6.4.2 Service icon in Systray
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If you use data bases or special drivers, before service run, these applications must be run. You can
specify what services should be started before Serial Printer Logger in the "Program depends on
services" window (fig. 6.4.3).

Fig. 6.4.3 Service settings #2

In some case you need to start Serial Printer Logger before starting other services. In this case you
should:
Switch a start mode of a target service to "Manual";
Start Serial Printer Logger;
Set on the target service at the "Services depend on ASDL" tab;
Select mode when you need start these service;
Restart Serial Printer Logger.
After you installed the service mode of the program, restart a computer or run the service manually
from the "Services" window in the Control panel (fig. 6.4.4)
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Fig. 6.4.4 Manual service run (in Window s 2000)

After start of the service, the service processes names will be displayed in a process list:
sprnloggersrv.exe and sprnlogger.exe (fig. 6.4.5). The 'sprnloggersrv.exe' application makes interface
between the service manager and the Serial Printer Logger software. Unlike srvany.exe utility, our
service stops safely.
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Fig. 6.4.5 Process list

If you want to configure the program as a service, then you must be logged with administrator rights.
The service application can be controlled, stopped or removed with help of a command line string.
Run sprnloggersrv.exe with following parameters:
/? - short help;
/I - install service for start in manual mode;
/A - install service for start in automatic mode;
/D - install service in off state;
/R - remove service from computer.
4.7.4.2

Windows Vista+ notes
One of the ways Vista's security was improved was by separating system services and user
applications into separate 'sessions'. Keeping the system services isolated helps to better secure
them, but also makes any interactive interface unavailable to the user. That's where the Interactive
Services Detection service comes in. When a service needs to interact with the user, Interactive
Services Detection presents a dialog that will switch the user to the session where the service is
running so they can interact with the service. For an excellent, detailed description of this, see next
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paragraph.
Many sites recommend disabling this service, but doing so will result in you not being able to
interact with any services that require your attention. This service is run manually by default, so
there is little point to disabling it unless you don't want to be bothered by important information from
the software you may be trying to run.
Display Name: Interactive Services Detection
Service Name: UI0Detect
Process Name: UI0Detect.exe
Description: Enables user notification of user input for interactive services, which enables access
to dialogs created by interactive services when they appear. If this service is stopped, notifications
of new interactive service dialogs will no longer function and there may no longer be access to
interactive service dialogs. If this service is disabled, both notifications of and access to new
interactive service dialogs will no longer function.
Path to Executable: %windir%\system32\UI0Detect.exe
Default Startup:
* Home Basic: Manual
* Home Premium: Manual
* Business: Manual
* Enterprise: Manual
* Ultimate: Manual

4.7.5

Restart & Security
Sometimes the program should be restarted. For example, if you've changed the program settings
remotely and want to reload program automatically with the new settings. To do that, specify the
time for restarting the program on the "Restart & Security" tab in program options "Options>Program options". Just specify the time of day, when the program should be being restarted.
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Fig. 6.5.1 Program restart settings

On this tab you can also protect some actions with the program by a password. To do that, activate
the "Protect by password" option, define a password and select protectable actions.

6

Having problems?

6.1

Program doesn't run or work
It is necessary to make sure in proper time installation on your computer, so as if you put clock after
program installation, protection from use after trial period works.
Also program won't work, if you started Softlce application debug environment or some other. In any
other case, please, inform our developers about your problems, our address support@aggsoft.com.
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FAQ
Question: Why COM port doesn't open?
Answer: Probably, some other program already uses it (COM port). This can be DOS application,
for example.
Question: What to do?
Answer: Close application, using this communicative port (for DOS application close also DOS
session window). Or use other communicative port. Probably, at start or some program stop was
made some fatal error and COM port wasn't properly closed.
Question: Is it possible to set variable data transmit rate or transmit 9 data bits?
Answer: No, Windows operation system doesn't let such liberties.
Question: What cutoff point type to use: DB25 or DB 9?
Answer: It makes no difference, select only in program corresponding COM-port. USUALLY DB25 COM2, DB9 - COM1
Question: Is cable connection direct or null-modem?
Answer: Everything depends on your device cutoff point. Usually it is necessary to use null-modem
cable, in which signals are moved apart in this way:
Device
|
Computer
_____________
RXD <--> TXD
TXD <--> RXD
GND <--> GND

if device uses special signals DTR and others and you don't want to use hardware data transmit
control, at device side connect 7 and 8 contacts of DB9 cutoff point or analogous DB25 cutoff point
signals.
More hardware tips and articles you can found on our site http://www.aggsoft.com.
Question: Is data receive becomes at once after program start or data receive must be started?
Answer: Everything depends on your device type, usually in device settings is selected to echo view
data to COM port. If your device doesn't support this mode, write what initialization string must be
sent to read out data, and we add this possibility to the program.
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